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Preface 
The fielding of AHLTA, the switch to the Next Generation of TRICARE Contracts, and the continued move 
to performance-based budgeting have resulted in transformational changes in the clinical, business, and 
administrative processes within the AMEDD. Multiple, often seemingly-competing, metrics and goals are 
presently in place. The apparent conflicts among requirements, metrics and goals often stems from each 
being treated as an end to itself. With completion of AMEDD AHLTA Block 1 Deployment (August 2006) 
and the fielding of AHLTA Build 838.18, the AMEDD will have the tools and experience with EMR use to 
bring these multiple metrics into a single process. Moreover, there will be the ability to centrally monitor, 
trend and report performance on core metrics. This ability will enhance MTF efforts to deliver optimal 
healthcare and target process improvement where needed. 

This document has evolved through an understanding of how AHLTA is being used and how it may be 
better employed. Close coordination has occurred with OTSG Health Policy and Services (HP&S) to 
determine the metrics that should be initially targeted. Since it would be overwhelming to try to correct 
hundreds of issues at once, items were selected that are felt to be of the greatest clinical value, that are 
current readiness or accreditation issues, or that are linked to current performance-based budgeting. The 
long-term goal is to establish and transform our culture to collaboratively meet local, regional, and 
Service-level needs in the most efficient manner possible. The use of integrated and automated 
processes will help facilitate the review and improvement of those processes using “Lean Six Sigma.” 
This will permit continued harvesting and sharing of best practices to benefit all MTFs, and most 
importantly, the care of the patient. 

The implementation of the process outlined in this document, like much of the AHLTA implementation, will 
not be easy. MTFs will experience varying degrees of difficulty depending upon current efficiencies and 
staffing of clinics. The AMEDD has undergone considerable transition in clinical practices to decrease 
variation, increase efficiency, and improve outcomes. Tracking the outcome changes (from the 
implementation of process changes) and the cost of delivering care (down to the clinic level) will help in 
making subsequent decisions on personnel and system transformation. 

It is the hope of the AMEDD AHLTA Project Office that this paper and its attachments will provide 
assistance at all levels within an MTF with successful transformation and outcome improvement in the 
areas of clinical care, readiness, and business processes. From continued field experience and command 
guidance, the Program Office will regularly update these documents. 

This document version addresses the use of appropriate free text by providers while using AHTLA as a 
Health Care team for efficiency.  This document should not be taken as an endorsement by the AMEDD 
or AMEDD AHLTA Program Office of Dragon Naturally Speaking.  The appropriate use of free text is 
acceptable and can work well inside of AHLTA.  Appropriate use will NOT alter the effectiveness of 
AHLTA coding or data mining.  Free text can be entered by typing, voice recognition, and handwriting 
recognition or “cut and paste” techniques.  The limitation of AHLTA free capacity in the MEDCIN tree 
must be understood for proper use of appropriate free text.   

Striving always to “Enhance the Excellence of Military Healthcare—AMEDD AHLTA.” 

 

 Very Respectfully, 

 

RON MOODY MD 
LTC, MC  
Program Manager, AMEDD AHLTA  
   Implementation and Clinical Integration 
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Section I — Overview 

Background 
AHLTA is the enterprise-wide electronic health records system for the Department of Defense (DoD) 
Military Health System (MHS). The AMEDD has now deployed the outpatient component (Block 1) to all 
MTFs. Since full-rate deployment started in January 2004, fielding and use of AHLTA has experienced 
many challenges. Various issues delayed the fielding of the local cache (failover mode) Build 838, but it is 
now being deployed. Besides its ability to allow AHLTA use when connectivity to the central Clinical Data 
Repository (CDR) is unavailable or the CDR is down, it comes with the first point-of-care decision- 
support tools, called wellness reminders. 

The wellness reminders are patient-centric reminders that focus on elements of the United States 
Preventive Health Services Task Force (USPSTF) guidelines along with military readiness issues. A full 
list of the available reminders is located at the end of this section. The reminders can be coupled to an 
action that resets the timer on when the action is complete and next due. Depending on the type of 
reminder and action, the reminder can be set to either enterprise or MTF level. This is required because 
reminders that require ancillary test ordering must be set to order from the local legacy CHCS system. A 
recent meta-analysis of decision support tools found that there are four critical features of these tools, and 
if all four are present, 94% of studies showed a significant improvement in clinical practice (BMJ 14 Mar 
05). The critical features are:  

1. Automated provision of decision support as part of clinical workflow 

2. Guidance provided as recommendations (actionable items), not assessments 

3. Guidance provided at time and location of decision making 

4. Computer-based  

AHLTA now provides these features. Additionally, the Automated Clinical Practice Guidelines (aCPG) 
outcomes tool that is being built will expand this capability further with the addition of registries and 
disease-specific information recall and reminders. In the expanded tool, the reminders will be patient-, 
condition-, and clinic-specific. Fielding of the aCPG tool is projected to begin with AHLTA build 3.3, likely 
to begin fielding in June 2007. 

Successful utilization of these tools will require both strategic and tactical implementation. The healthcare 
process could easily be overwhelmed with a mass of reminders to address. The strategic prioritization for 
fielding the reminders is critical. Additionally, each of these should be considered an extension of a single 
process aligned with organizational goals and policies. Tactically, the implementation must be performed 
so that efficient use can occur and neither time nor effort is lost as patients and healthcare team members 
move. 

This document outlines a process of care and recommends performance metrics to be evaluated for 
continued improvement. 
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Section II — The Outcomes-Based Clinical Care Process 

Introduction 
Historically, each new initiative to improve outcomes has been treated as a separate event. Each 
implementation came with a clinical or functional champion, process, metrics and often an entire Process 
Action Team. This method is costly to implement, track and sustain. The efforts at one MTF often did not 
translate to improved outcomes at other facilities, as either different outcomes were emphasized or the 
process was different, thereby failing to reduce the work burden or cost. This implementation cycle was 
typical of the process used to field clinical practice guidelines. Clinical outcomes are not the only 
outcomes of concern. Others include readiness, business (financial) and regulatory (JCAHO, DoD, Army, 
etc). These outcomes were often tasked to a section of the facility for accountability, yet one who did not 
have control over the actions necessary to achieve the outcome. Achieving (or attempting to achieve) any 
outcome carries a cost to the MTF in personnel, equipment, and other direct costs. The performance of 
many interventions simultaneously does not make them more effective, but it can make them more 
efficient. With common overarching processes at each MTF, global efficiency is improved as the total 
burden of work is diminished. Finally, the cost to the patient in time and illness cannot be a secondary 
event. Efficient delivery of care and improved outcomes have direct benefit. The move to Relative Value 
Unit (RVU) monitoring of workload has provided the business model to allow focus on better care while 
maintaining productivity. The additional metric of Cost (salary)/RVU can further measure efficiency.  
Analogous to an automobile the metric utilized depends on who is measuring and what the goal of having 
the measure is.  Clinic data = RPMs, equivalent to the number of scheduled visits that are filled; MTF = 
speed, equivalent to Cost/RVU; and RMC = distance, equivalent to total RVUs.  The Per Member per 
Month (PMPM) cost at the AMEDD level provides a measure of global effectiveness. 

For each of the steps in the clinical process that follow, a recommended series of actions is listed. These 
actions emphasize the team approach and target specific metrics. The actions are actionable locally and 
can be monitored centrally. It is hoped that all future regulations will include sections specifying 
recommended ways to accomplish the tasks with the available tools, associated metrics, and 
methodology. This will allow continued organizational synergy and ensure effective IM/IT tools.  

Check-In — Clerks 
The clerk will check the patient in to his/her appointment. The following actions may be accomplished: 

1. The clerk will open the patient demographics 
folder 

A. Local telephone contact information will 
be placed in the local information free text 
area which is labeled Comments. This 
area is NOT overwritten by DEERS. (Note: 
this assumes that the information in CHCS 
is updated as part of the normal process 
when a patient calls for an appointment 
booked in CHCS.) 

It is important to close the patient 
demographic module after work is 
completed so that the information is saved 
in the record. 
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B. Insurance status is reviewed and a date is entered in the "expiration date” field to indicate the next 
date to check status (annually). 

1) If the Other Health Care (OHI) insurance check is current (within the last year), no action is 
needed. 

2) If over one year, the clerk will update the information and, if the patient has third-party 
insurance or a change in third-party insurance, a paper form will be obtained and signed before 
leaving the check-in desk.  

 

 

 

By clicking “Enter Changes to Patient 
Insurance Information”, a new area 
will open allowing modifications and 
changes to insurance information.  

The patient’s encounter must be open 
for this function to be available. 
(Example to the left.)  

Hard copies of this information should 
also be maintained and sent to 
appropriate MTF areas to ensure data 
is accurately captured.   

 

 

 

 

 

 

 

 

2. AMEDD Annual Screening Questionnaire 

Clerk checks to see if annual questionnaire is current, and if not, assigns PIN (for AHLTA kiosk) or 
indicates to screeners (for paper or other method) that the questionnaire is due.   

Note: The clerk will need to be assigned one of the following roles depending on the workflow used: 
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A. Ward clerk — permits the user to assign and view questionnaires. 

B. Ward clerk with limited orders — as above and allows the clerk to address reminders.  

 

 

3. Questionnaires — Future State:  

A. The Questionnaire tool will include dropdown selections for patients and include questions that 
patient MUST answer (Build 3.3). 

B. The Questionnaire tool will include items that flag alerts to the medical staff depending upon the 
answer given. This will be useful in numerous areas, including prescreening, such as ADTMC (Build 
3.3). 

C. Clerks will complete third-party insurance on a form in AHLTA that can be e-mailed in a secure 
fashion to the TPOC office. 

D. Patients will be able to sign themselves in using their ID card. Upon checking in, the computer will 
present “forms” that the patient needs to complete or are due, such as the HIPAA privacy statement, 
TPOCs, etc. The clerk will verify and assist patients with form completion and computer use issues. 

Screening/Vital signs 
The screener will review with the patient his/her current medications, to include prescription compliance 
and over-the-counter (OTC) meds. They will also update the problem list with any change to the patient’s 
family or surgical history, allergies, and problems. 

The screener will check the patient questionnaire history (if not already performed by the clerical staff) to 
see if the AMEDD Annual Screening Questionnaire has been completed in the last 12 months. This 
questionnaire is used to meet both annual JCAHO screening questions requirements and the Army’s 
Periodic Health Assessment requirement. The same form is used for all patients 17 years of age or older.  
If the questionnaire has not been completed by the patient in the last 12 months, the screeners ensure 
that a current questionnaire is completed. Only the AMEDD Annual Screening Questionnaire in the 
Enterprise Questionnaire folder will be used for this purpose as its use can be viewed and monitored by 
all MTFs. 
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After completing the above, the screener will complete at least the minimal items listed below in the 
screening and vital signs modules. The AMEDD Screening AIM form will be used to capture the items 
listed below after they are reviewed with the patient. The screener should not waste time documenting 
items in the screening and vital sign module that will be captured on the AMEDD Screening AIM form. 
The items completed will allow central monitoring and reporting on MPL maintenance and medication 
reconciliation actions. 

1. Items to document 

A. Screening 

1) Encounter Context (Related to injury?). This box will be checked “yes” if this is the first visit for 
this condition related to an injury.  

2) Female data as appropriate. 

 

Please ensure that all data in the Related to Injury/Accident field is 
complete, including the date the incident happened and the location.   

3) Wellness reminders will be addressed as follows: 

a. Active duty.  For some clinics and reminders, “appropriately addressed” may simply mean 
reminding the service member this is due and providing appropriate directions.  Others 
require orders or other action.  The reminders are found in the A/P module under the 
Reminders tab.  

(1) DNA 

(2) HIV 

(3) Sickle 
Screen 

(4) G6PD 

(5) Immunizat
ions 

b. Others — Per 
clinic SOP 
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B. Vitals 

1) Standard Vital Signs 

2) Height/Weight 

3) Pain Scale and comments (if a value of “1” or greater is recorded). Comments should address 
location, duration, and current treatment.  
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C. AMEDD Screening AIM Form  

1) Reason for visit and narrative in patient’s words entered in free text 

2) All other questions on the form that are addressed. (Note: This permits the compliance actions 
to be tracked, as these specific MEDCIN terms will be tracked) 
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2. Current Workflow Considerations 

A. Nursing station can print the AHLTA SF600 with Autocite included for the patient to review while 
getting vital signs taken or while waiting for screening. This will allow the screener to only open 
modules where changes need to occur. (NOTE: Family history should note be autocited due to a 
programming error UNLESS you are using 838.20) 

B. The nurse places this sheet and any necessary additional comments in the location that the 
provider will be able to see it. (e.g., Exam room door as a clinic tracking sheet.) 

3. Actions 

A. Refresh Autocite 

B. Per clinic SOP and depending on available time, take action to update issues listed in the 
reminders. 

C. Autocite the Annual Questionnaire into current encounter. 

D. Document all immunizations in AHLTA, including those on active duty. Only document active duty 
immunizations in MEDPROS if the patient is at an SRP site. MEDPROS use for immunizations will be 
discontinued when the CDR/MEDPROS bidirectional interface is active.  
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Using the Vaccine History Tab, the patient’s immunizations may be reviewed and updated.  To 
update, click the Add button located at the bottom left.  This will be especially important for active 
duty personnel.  

4. Future State: 

A. Patients will update information in their AHLTA problem list using TRICARE Online (TOL). The 
staff will verify the information and it will be placed into AHLTA. (Part of HAMTD project – Funded) 

B. The aCPG tool will provide patient-, disease- and clinic-specific reminders. This will also include 
automatic retrieval and display of defined test data in the encounter note. (Scheduled for AHLTA 
Build 3.3) 

C. Vitals signs captured by screening staff will automatically feed the coding calculator so that the 
screener or providers does not have to click these buttons in the MEDCIN encounter. (Build 3.3) 

D. Screening and vital signs modules will be merged into a single module. (Build 3.3) 

1) Allows for all entry from one module. 

2) Includes use of the AIM Form as above. 

3) Permits clinic-specific templates or other AIM Forms to be surfaced for clinic-specific 
questions. 
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Provider (See also Section VI — Best Practice for Utilizing Other Technologies 
with AHLTA) 
1. Reviews information entered by staff. (Notes:  If in a wireless environment and using a laptop or tablet 

this can be done prior to entering the exam room to speed up the encounter.  Without wireless, the 
review is conducted by clicking on the S/O section.  The provider should limit the numbers of jumps 
from S/O to A/P as this adds time to the encounter.  This issue is resolved in Build 3.3 as the user is 
logged into both modules simultaneously which significantly speeds navigation.) 

A. Assumes control of the S/O note started by staff using the “EDIT—NO—YES” steps and edits 
initial information entered by staff if needed. 

B. Addresses pain and compliance issues, as appropriate, in encounter note 

2. S/O—Completes S/O using AIM form specific for voice recognition pilot.  It will usually be most efficient 
to complete the A/P section with the patient present and then dictate the A/P section immediately 
after the patient leaves the exam room.  Extra noise in the room and interruptions make dictation 
specifically and S/O completion generally more difficult.  

A. AIM form for specialty is designed with specialty input.  The AIM form contains only necessary 
terms for clinical documentation and to meet coding or other requirements.  The MEDCIN terms 
chosen often take into account the fact that only ½ page or 2,000 characters can be entered into any 
comment or free text box in AHLTA.  The only area that can accept large areas of free text is the 
AddNote section. 

B. Recommended Work process 

1) Utilize the team documentation and update Problem List and Past Medical History items in the 
problem list.  DO NOT use free text or dictation to add past medical, surgical, or family history in 
the note.  Entering the information on the problem list allows this data to be entered once by all 
providers. 

2) After reviewing the items entered by staff, move the appropriate free box after a MEDCIN term 
to enter free text.  You can type, dictate, or use handwriting recognition for this.  Dictate only the 
finding related to that term.  Remember that the limit is ½ page. 

3) Continue dictating or entering free text to complete your note as above. 

4) It is also important to use narrative comments in the Comment Box under the Diagnosis in the 
A/P window.  This can also be done by typing, dictation, or handwriting recognition. 

5) If there is a lengthy comment or discussion that needs to be added to the note, the AddNote 
section should be utilized.   

3. A/P Module (Note: If using a tablet, it is best to have the tablet in keyboard mode as the A/P section is 
not optimized for tablet entry.) 

A. Diagnosis and Procedures 

1) Use the patient Problem List to re-enter the previous diagnosis by double-clicking.  This is the 
fastest method and keeps the Problem List cleaner.  (The ability to do this is fixed in AHLTA 
Version 838.20).   

2) The pre-configured Clinic Favorite List should include most common Diagnoses and 
Procedures. 

3) The Order Set attached in the default encounter template can also include those ancillary 
orders that are most commonly used in the clinic or by the individual.     
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B. Medications 

To edit current medications click 
the More Detail button; this will 
allow immediate review and 
modification/deletion of current 
medications.  

1) Enter modifications to any medication that the person is currently taking, to include modifying 
current prescriptions and deleting/making inactive medications that are duplicates or no longer 
needed. 

2) As noted, most short-term medications that are prescribed should be on the Order Set tab that 
is associated with the specific AIM form being used. 

3) The provider should add any OTC meds or adjust items entered by staff via the medication 
module. 

C. Wellness Reminders — Sign or address wellness reminders as appropriate. 

D. Past Medical or Surgical History — Update/modify as appropriate using the Problem List if the staff 
has not completed or if modifications are needed.   

E. Ancillary Orders 

1) Common orders should be included in the order set associated with the AIM form in the default 
encounter template. 

2) Clinic favorites for each of the ancillary tests should also be created and used to prevent 
searching for items. 

4. Readiness Module (when mapped) 

A. Review items 

B. Documents 

1) PHA Date completed (Date of that exam). 

2) Deployable status — as of that date. 

C. Use AHLTA profile module as appropriate 

5. Signing — Signing notes indicates review and concurrence with team-entered documentation. 

6. Future State: 
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A. Vital signs will no longer have to be clicked in template or AIM form. The patient status as an 
established or new appointment will also be automatically determined. (Part of Coding automation 
enhancements — Build 3.3). 

B. The provider will be automatically signed into CHCS and the CDR so that module changes will be 
faster at the point they open a patient’s encounter. (Part of Performance Enhancement — Build 3.3). 
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Section III — Metrics and Monitoring 
Although this process may seem daunting and time consuming, the time associated with its use will 
decrease for everyone as its use across the AMEDD increases and the baseline documentation level 
increases. The time needed to document will decrease when only changes to previous visit history are 
required to be documented and as the skills of those performing documentation improves. There will also 
be reduced work as all sites are supporting each other.  The providers’ documentation time should 
decrease as the supporting healthcare team completes more of the documentation. Central monitoring 
and reporting will remove the reporting and tracking workload burden from the MTFs, allowing personnel 
re-allocation to support direct patient care. Finally, additional metrics targeting additional outcomes for 
improvement will be added in stepwise fashion. 

Metrics 

1. Percent of patients with the following reviewed and updated at each visit (metric by MTF and clinic) 

A. Problem List 

B. Family History 

C. Surgical History 

D. Medication (medication reconciliation) 

2. Percent of patient visits that had the annual questionnaires reviewed within the last twelve months. 

3. Percent of patients that had Pain Scale documented at each visit. 

4. Outcomes (My MTF) 

A. Mammogram compliance (HEDIS) 

B. Pap smear compliance (HEDIS) 

C. Diabetic Care — Hemoglobin AIC ordered appropriately 

D. Pneumococcal Vaccination Rate (over age 65 seen in primary care clinic) 

E. Readiness 
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Section IV — Policy Review 
The AMEDD AHLTA Program Office will work to review and link related AHLTA policies to this guidance.  
This will aid in developing a systematic approach to improving outcomes, tools, and processes from 
enterprise feedback. This includes the ability to capture and centrally monitor/report the data as 
appropriate. 

Local policies should also be reviewed to determine if changes are warranted to improve efficiency and 
reduce unnecessary work. Duplicate information entry and tracking should be avoided.  
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Section V — Best Practices 

Medication Reconciliation 
This is accomplished by using the process outlines in the document.  Central monitoring will be possible 
by determining the number of encounters where the medications were reviewed and updated button was 
checked.  It is also recommended that local policy be developed and understood that the provider’s 
signature of an AHLTA encounter signifies that medication reconciliation occurred. 

Creating and Updating the Master Problem List 
Long before medication reconciliation was an issue, the JCAHO required that a master problem list (MPL) 
be created by the third primary care visit and maintained thereafter.  This process is the foundation for 
medication reconciliation and could be called healthcare reconciliation.  Updating the MPL requires 
current medications, allergies, procedures and family history be documented.  The steps for 
accomplished this are imbedded in the process outlined in this document and can also be centrally 
tracked as above.  The MPL will require maintenance to eliminate unnecessary items until this process 
becomes more automated. 

Maximizing Prevention (Winning at PBAM) 
The MEDCOM has started performance based incentive programs that provide increased funding based 
upon population health.  The method to document this care in a team fashion is outlined in this document.  
The use of wellness reminders and immunization module can expedite the process of insuring prevention, 
and readiness occurs as part of normal care.  This will help insure the best possible care of the MTF’s 
population while improving funding.  To avoid overwhelming the healthcare system in “catching up” on 
outcomes as the new processes are put into place, activation of reminders and monitoring of outcomes 
will be prioritized. The initial outcomes have been prioritized based upon current regulations and 
documented evidence of health outcome improvements. Where possible, the ability to clear the reminder 
should be done during the visit (I.e. giving and documenting pneumovax) and all care provided outside 
the MTF (direct care system) should be documented using the wellness reminders. 

Periodic Health Assessment (PHA) 
As noted in the document, the PHA can be accomplished along with the annual JCAHO questionnaires.  
The other aspects of the PHA are met as the medication and healthcare reconciliation process is 
completed.  The only additional step needed is the provider documenting that the PHA was completed 
during this visit regardless of the reason for visit.  PHA does not require a special visit but does require 
the procedure to review and, as appropriate, address the patient health issues. The documentation that 
this occurred can be made by using the readiness page in AHLTA as noted below.  This information will 
be provided to MEDPROS for reporting and tracking purposes.  It is recommended that the annual 
physical reminder be used as a visual reminder of the need to complete the PHA and that it was 
accomplished. 
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Provider Steps: 

 
1. Verify “Annual MEDCOM Questionnaire” has been completed, address medical issues of the Soldier 
and consult as needed 
2. Click on the “Readiness” button at folder 

A. Click on “Edit” button at top menu  
B. Enter date for “Medical Assessment (PE)”  
C. Click on “Save” button  

3. In A/P module: at bottom, click on “Reminders” tab  
A. Select actions you wish to order, check as complete  
B. Click on “Submit” button  

4. In “Disposition” module:  
5. Click on “Admin Options” button in center of page  

A. Check appropriate buttons  
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Section VI — Best Practice for Utilizing Other Technologies with AHLTA 
There are many technologies that work natively with and inside of AHLTA.  These include voice 
recognition which is part of the software in tablet PCs as well as specific voice recognition products such 
as Dragon Naturally Speaking.  Additionally, tablets allow touchscreen utilization to move the cursor as 
well as handwriting recognition.  The value of these technologies will depend on the individual provider’s 
preferences and the work environment.  Below the current best practices are discussed; the use of these 
IT tools should be part of the larger team process discussed in Section II. 

Voice Recognition 
Most providers find that it is best to dictate after the encounter once the patient has left the room.  With 
voice recognition this is in part due to less ambient noise.  Voice recognition software requires some 
minimal training.  Accuracy of each application occurs with increased use.  The use of a noise 
cancellation microphone and low ambient noise levels will help with accuracy.  Microphones can either be 
worn as a headset (this is the microphone typically paired with Dragon) or handheld.  Provider preference 
will determine type.   

Not all parts of AHLTA have been designed for voice recognition or voice navigation use.  With the 
Dragon product, pilot projects are underway to improve voice navigation and those lessons learned will 
be added to this document as they are learned.   

Recommended Provider Workflow:  

1. Enter room and open encounter and load Health History Module 

2. Review with patient information and examine patient 

3. Complete A/P with patient present this will be done largely with typing and the provider should be 
using order sets.  Dictation will likely be used in Comments boxes under the diagnosis. 

4. Patient leaves exam room 

5. Open S/O to complete note.  Click on the relevant MEDCIN term and dictate clarifying data into 
the free text box.  Remember the ½ page limit.   

6. Consider using DX Prompt and/or Prompt functions to find additional terms that were not part of 
the base template or AIM form that you are using. 

7. Sign notes at a convenient time. 

Tablet PC 
Tablet PCs offer two primary additional benefits besides being able to use the native TabletPC voice 
recognition feature within AHLTA.  These features are touchscreen control using a stylus and handwriting 
recognition.  The use of the stylus can allow quick navigation and “box checking”, though many parts of 
AHLTA are not optimized for use with a stylus.  Handwriting recognition is another form of free text entry 
like dictation.  For those who have used Palm or other handheld devices, this feature will be easy to use.  
There are two ways handwriting recognition can be used: cursive and printing. Advances in this 
technology along with a medical dictionary applet make the cursive the easiest to use.  Other user options 
that must be set for efficient handwriting use are “undocking” where the writing surface arrives and when 
written words are entered.  User preferences will determine these settings and will take some practice. 

Recommended Provider Workflow: 

1. Enter room and open encounter and load Health History Module 

2. Review with patient information with tablet in keyboard mode and examine patient.  
Complete A/P with patient present. This will be done largely with the tablet in keyboard mode and 
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using order sets.  Handwriting recognition and stylus may be used for navigation and to enter free 
text in Comments boxes under the diagnosis. 

3. Patient leaves exam room 

4. Open S/O to complete note using a template or AIM form.  The tablet is used in “slate” mode to 
write on the screen.  Click on the relevant MEDCIN term and write using handwriting recognition 
to enter clarifying data into the free text box.  Remember the ½ page limit. 

5. Consider using DX Prompt and/or Prompt functions to find additional terms that were not part of 
the base template or AIM form that you are using.  

6. Sign notes at a convenient time. 

Wireless 
The primary advantages of wireless are 

1. The same as a tablet above since tablet PCs are being deployed to be used with wireless. 

2. Main Benefit - Loading and viewing patient information in the hallway 

a. Open encounter and click on Health History Module (HHM); this retrieves all patient data 
and “stores” it for faster retrieval 

b. While HHM is loading, review note for today which should include information entered by 
the nursing staff 

c. Once the HHM is loaded, ancillary test and other information will be retrieved faster on 
the tablet. (Note: Ensure all settings for lab and rad retrieval are set appropriately) 

d. Note: yes, you can “store” several patients’ information for quick retrieval by opening their 
HHM once they have been checked into the clinic. 

3. Secondary Benefits 

a. Use in hallway to enter orders or other items that you may have forgotten 

b. No repetitive signing on to AHLTA (saves time) 

c. Completing tasks in meetings, etc 

d. Review next patient’s notes. 

Using PDFCreator for Placing Information into AddNote 
Background: Anything that can be printed from a system (i.e. EKG, PFT result, EGD Summary report, etc) 
can be quickly captured and place into the AddNote section of AHLTA using PDFCreator.  This software 
installs an additional print driver on your computer.  Printing to this “virtual printer” will allow you to quickly 
capture an image one page at a time and place into AddNote.  Installation and setup instructions are 
provided in the Appendix. 

Once the software is loaded, the steps to place information into AHLTA are: Print to PDF, use the 
Snapshot tool in Adobe Reader to copy any area of the document, then paste directly into AddNote. 
Detailed instructions are provided below. 

It should be noted that this work process does not require AHLTA to be on the workstation where the 
information is collected. Documents and images can be saved from the system that creates the report to 
a folder on a shared network drive for later access by a computer on the network that has AHLTA. HIPAA 
restrictions should be observed regarding file names and retention. 
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PDFCreator can be used at any time once installation and setup are complete. For this example scenario 
we will use Microsoft OneNote, but this process will work for any application that would normally be 
printed and scanned. 

 
1. After completing your note in MS OneNote, click Print. When the dialog comes up, choose 
PDFCreator as your printer and click OK. (Note: you can also set PDFCreator as your default printer, but 
this will affect all programs on your workstation. You may want to do this while you are in clinic as this 
significantly speeds up the process.) 

 
2. PDFCreator will convert your file to PDF, then open it using the Adobe Acrobat Reader 
application on your workstation.  

 
3. In Acrobat Reader, click on the Snapshot button on the toolbar or click Tools, Select and Zoom, 
Snapshot Tool.  
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4. Drag the box to highlight the area you want to capture. When you release the mouse, the area is 
copied to the computer clipboard.  It is now saved in a format that you can paste into AddNote. 

 
5. Open the AddNote module for the patient, click New Note, then Paste the image into the note 
area.  

 

 

 

 

 

 

 

 

 

 

 

 

 
6. Name the Note as appropriate and complete the encounter.  
 
7. Note: It will take about 5-10 Seconds from selecting print to the document displaying in the PDF 
reader; this time can be used to open AddNote.  It is much faster than scanning and you will know that 
the information you wanted was placed in the note.   
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MS OneNote 
Microsoft OneNote is a standalone application that allows users great flexibility. You can add images and 
partial screenshots from any source on your computer (including the internet, other applications like Word 
or Excel, or any proprietary software that computes clinical results and displays them on your screen) to 
OneNote, then markup the images however you like, using your mouse, draw pad, or Tablet PC stylus. 

Clinical Scenarios using OneNote 

1. Capture results of a retinal exam and paste the screenshot into OneNote, then highlight 
significant results. 

2. Import a blank form, such as a diabetic retinopathy screening exam, then fill out the form.  

3. Annotate illustrations just as you would on a paper form using different colors and line styles. 

4. Add handwritten or typed comments. 

5. Any combination of the above, all in the same OneNote file. 

Any image can be pasted into OneNote as in 
the example to the right.  Then any 
annotations (drawings, hand written notes, 
etc) can be added. 

 

Overprints (called stationary in OneNote) can 
also be used as in the example below. 

 

You can draw in multiple colors, erase, and even use 
handwriting anywhere on the image.  

Anything that is drawn can be moved (using the 
type/selection tool).   
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When finished annotating in OneNote, PDFCreator can be used to output it into whichever file type that is 
needed.  You can set PDF Creator as your default printer (see BBP for PDF Creator) or select PDF 
Creator each time.  Note: you can change the default printer at the start of Clinic.  

 

 

 

 

 

 

 

Steps for the first time user 

When opening the application for the first time, the OneNote 
Drawing/Writing tool should be set up in this manner: 

Selecting View-> Toolbars -> Drawing and Writing Tools will 
display the tool bar. 

The tool bar can then be moved to either side of the window.  
This increases the ease of use. 

 

 

 

 

 

Steps for OneNote use 

OneNote is now ready to be used.  The steps are as follows: 

1. If no project is opened, this is what will be seen: 

Clicking anywhere in the application work area will bring up a new section. 
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2. Now the project is created and time stamped.  The title can now be entered. 

 

 

 

 

 

 

Multiple pages can be created or opened at once.  

The button at the bottom right toggles between the page number and the title of the 
page. 

 

3. To import items into OneNote, proceed with the following 
steps: 

If an image: Insert -> Picture -> From File. You can also 
Cut -> Paste any image you like. 

If a document: Insert -> Document as picture 

Most documents can be imported this way, allowing for a 
wide range of options.  

Note that you can copy and paste any photo that is 
displayed on your computer. 
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ginal title of the 

 

ported into OneNote is something that will be used multiple times, it will be easier 

Note follow these steps: 

bottom of the list that is 

page as stationery 

 as to 

 

 My Stationery  

 

After being imported, OneNote 
automatically places where 
the Document came from at 
the top.  If this is not needed, 
it can be removed by selecting 
it and pressing delete. 

The ori

0) 

document is also taken by 
OneNote.  It can be renamed 
by simply selecting the title 
and entering the desired title. 

4. Once you complete a note
on a patient, you can clear the 
information simply by clicking 
+ dragging across, 
highlighting all the items you 
wish to clear, then pressing 
<DELETE>. 

5. If the item that was im
to create Stationery from it. (We can help) 

To create Stationery from anything imported into One

Format->Stationery… 

Select the option at the 
displayed:   

Save current 

Name the Stationery appropriately so
avoid confusion in the future. 

 

 

 

 

Now to create new OneNote items:   

File -> New -> New from Stationery ->

 



 

External Information (i.e. network consults) into AHLTA 
Consult Referral Centers 

If you receive consults via fax, you should have a computer set up to receive your faxes.  This can be 
done in several ways with available software and will ensure that the consult is captured as you never run 
out of paper.  It also removes the time-consuming task of scanning the document.  If you receive a paper 
copy, you should follow the instructions for best business practices for scanning and scan as a PDF file.  

Once you have the consult in the computer, you can use PDF creator as above to add 1 page at a time to 
clinical notes. 

Miscellaneous Interim Uses 

1. Consent forms signed by the patient – Create stationary in OneNote that is the consent form.  
Have the patient sign the form.  Use PDF creator to place in the record. 

2. Patient drawing for mental status exam – Use any drawing application with the drawpad or tablet 
along with PDF creator. 

3. Army Physical placed into AHLTA 

4. Etc… Let us know your innovative solutions. 
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Additional Resources 
Please refer to the following documents for additional information available on the AKO AHLTA 
(https://www.us.army.mil/suite/page/406) references page and on the USAFP website 
(http://usafp.org/CHCS-II-AHLTA-Information-FAQs.htm). 

1. 838 User Manual 

2. Provider Manual 

3. Nursing Manual 

4. Business Process Re-engineering (BPR) for AHLTA and TNEX 

5. B  

6. Immu

7. Welln

est Practices/ FAQ 

nizations 

ess Reminders: Set-up and use recommendations 
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